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These notes were prepared from comments contained in the MilkShape program, from open source commentary, and from other users. It also contains material from examples used by the author in teaching a course in Graphics and Simulations using MilkShape and OpenGL.
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Introduction to Milkshape
An Introduction to Modeling

Before we actually move on to the actual making of a model we have to first discuss a few things about what modeling is and how it is used. 
3d Modeling
3d Modeling is the art of creating models that can be understood by the game design and development software. These models have to be made in 3 dimensions so that you can rotate and look at them from all angles. 
In many cases you will also want to animate these models so they move. You might want actions like swing a weapon, jump, swim, wave, shoot a weapon or anything else you can imagine. 
How do you create a model?
You use a program like Milkshape 3d. There are actually many different programs you can use to make game models and we are going to use milkshape 3d because it has a 30 day free trial period and because it is very easy to use in conjunction with OpenGL.
If you learn the basics of modeling with milkshape you will have set yourself a nice foundation for easily learning other programs. 
When making a 3d model your milkshape gives you a workspace to work in. Here is the milkshape workspace with a model of a dwarf and his axe ready to be worked on. 
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This workspace gives you a lot of tools (along the right) and also shows you four different views of the model. Front, side, top and skinned. Skinned is the white version in the lower right. 
If you take a close look at the picture above you will see three very important color coded things inside the dwarf. 
First off there is the red color, then you see a bunch of blue circles, and deep inside the dwarf you see yellow lines. These are the basic structures of the model.
The Skeleton and the Joints
When you play a video game you don't see the skeleton and joints of the models so why do you need them? 
These are very important because they tell the game how the model will move. The following explains motion and the skeleton structure under your model.
Imagine this image as your forearm. You can see the joint at the elbow and the joint at the wrist. The bone runs from one to the other. What if you want the arm to move so the elbow stays where it is at and the wrist moves to the new position shown by the arrow. 
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Without a model you would have to animate this by drawing a new model in a bunch of different steps so it shows a smooth transition from the beginning point to the end point. This could be a real lot of work. Think about all the drawings you would have to make so it looked smooth. And you are not just moving the arm, you are also moving the head, torso, legs, feet and hands. 
If you were drawing just a simple line it would be relatively easy to draw all the steps in between. But what if you had something like our dwarf where there is a lot of complex stuff going on like armor, clothes and an ax? It would take you forever.
This is why we do the skeleton and joints. Once they are created you define the beginning point and the end point and the computer draws out all the images in between. It saves a lot of time. 
So this is where you start, by making a Skelton for your model. Here is a basic human skeleton right out of the milkshape program. It comes with the program. 
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With the skeleton and joints in place you still don't have a model that looks real or even has any substance at all. It is just the underlying components that tell the model how to move. You still have to make your model in a realistic manner. This is done with the wireframe and the skin textures. 
The Wire Frame and Skin of a Model 
You have a skeleton, now you need to make it real
After the skeleton has been created there are two more things that you need to do to bring it to life. 
You have to create the wire frame structure that defines the shape of the model then you have to create the pictures that will go on it. 
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This Model was downloaded from 3D-Resources.com
http://www.3d-resources.com and created by Psionic 
The picture above with all the red lines is the wire frame structure of the dwarf. This is the shape of the model. It is built around the skeleton and it could be any shape at all. You could make the dwarf plump, skinny, or change the shape of his head, arms, etc. 
Important concept: This is polygon modeling and all of these shapes you see are triangles. The skin of your model will be a series of dozens, or even hundreds of these triangles. All the modeling is done by assembling groups of triangles together. 
This polygon modeling with lots of triangles brings up an important point. The more triangles you use the more detailed your model will be - and the more work it is. 

Now that you have the shape you have to also define the skin and you do this by creating a picture that will be poured onto the model. It looks kind of strange but this is what you would make:
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This Model was downloaded from 3D-Resources.com
http://www.3d-resources.com and created by Psionic 
This is the final product for the dwarf animation. It defines how the dwarf looks all the way around and it makes things much easier for you. The game will take this image and pour it right onto the dwarf skeleton and wireframe. 

 

Okay, you have a basic understanding of what modeling is and you have a grasp of some of the fundamental concepts like the skeleton and the triangles. Now let’s get the Milkshape program and start familiarizing ourselves with it. 
Downloading and Becoming Familiar with Milkshape
Milkshape 3d is the product of a company called chUmbaLum sOft and it is not a free program. You have to pay to register it but it does have a 30 day trial period so you can give it a good try and see if you like it before you decide to register it. 
On the milkshape home page, in the left hand column you see a link called "Download" go to that page and download the latest version of the software. As of the writing of this tutorial the latest version is: 1.7.10 
It is a reasonably small file (4.8 Meg) so unless you are on dial up it should only take you a few seconds. 
After you have it downloaded unzip it and run it. 
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To run it you should have a desktop icon that looks like this:
If you don't have this icon on your desktop you can run the program by using start > all programs > Milkshape3d 1.7.10 > milkshape3d 1.7.10.
.

Now that you have Milkshape 3d open let’s take a look at some of the features of the workspace. There may seem like a lot of crazy stuff but in no time you will be real good at using this program. 
Familiarizing yourself with the workspace 
Now that you have Milkshape 3d open let’s take a look at some of the features of the workspace. There may seem like a lot of material but in no time you will be very proficient at using the program.
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The Tools in the Workspace
The Biggest Feature of the workspace is the four large boxes that take up most of the space. Three of them have grey backgrounds with black lines and the fourth one is mostly blue. And they show your model from three different views. The top left square is the front view, the top right square is the side view, the bottom left square is the top view; And the blue square is the skinned view. 
About the skinned view: The three grey view show the structure of your model and the skinned view gives you a view of how it will actually look in the game. 
Most of this type of modeling software has a very similar look. An important thing to remember about this is that no matter what software you use you will learn some good skills that will transfer to other programs. So, if you are planning to be a professional game developer using a free or inexpensive program like Milkshape 3d will prepare you well for when you start using the very expensive professional programs. 
Milkshape is not as powerful as the professional programs but it teaches you the concepts of vertexes, wire frames, skinning, animation, joints and more.
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Let's take a closer look at the other parts of the workspace. 
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The big box of buttons and tabs on the right side of the screen are where you will do much of the work. There are four tabs labeled Model, Groups, Materials, and Joints. Click through these tabs and get familiar with what it all looks like. You will use this tool box a lot. In particular the Model Tab is where you will do a lot of your work. It is shown in the picture on the left here. 
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And at the top of the workspace are the familiar menu items. There are a lot of easy to understand tools here like File, Edit etc. We will go through the other items as we need them. And remember that if you get stuck you can always look through the Help menu. 
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At the bottom of the workspace is a tool called the Animation Slider. This is where you can view the motions of your Character. 
Okay, you have a sense of what the workspace is all about. Let's start building a model. 
Example 1: Creating a Sword
Creating Your First Model Box and Using Viewpoints
We are going to make a very simple model of a sword. This will show you some of the basic techniques of modeling including the concepts of symmetry and welding. 
Symmetry and Welding 
Symmentry is the concept of having two halves of something that are exactly identical. Picture a sword cut right down the middle from tip to handle. Each half of the sword is exactly like the other. With modeling, and particularly with complex models we only have to build one half of the model then duplicate a mirror image of it and weld the two halves together. This makes your model look better because it is perfectly symmetrical and it makes the process much easier. Think about the dwarf we used as an example earlier in this tutorial. you wouldn't have to model the whole dwarf. You could just model half of it then create a mirror image and weld them together. 

In the toolbox on the right of the screen push the button called "Box". Using the box tool will make it real easy for you to create a three dimensional shape. 
In the Front View Window (the upper left square) click hold and drag your mouse so you create a red rectangle that looks like the one shown below. This is one half of your sword blade. Well kind of. Whoever saw a sword blade that is 1 inch wide and a foot deep? We are going to modify this. 
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But before we modify this we need to understand how to manipulate the screen.  The skinned image in the lower right hand box is rather interesting. It actually looks like a solid object. Let's move around a bit and view it from different angles. This is an important skill because as you create complex objects you are going to have to move your viewpoint around quite a bit. 
Looking around the model 
[image: image65.jpg]


Roll your mouse over the Skinned (Blue) view and press the left mouse button, hold the button down and roll the mouse around. See how the view changes? 
This is an easy way to get a good look at the different sides of your model. 

 

Zoom In and Out 
[image: image66.jpg]


Now roll over the blue workspace and hold the shift key down, Then press the left mouse key and roll the mouse around. 
This is how you zoom in and out. 

Rotate around the Axis 
[image: image67.jpg]


This is another very useful visual tool for looking at your model. 
You can see a little yellow dash on the grid of the viewpanes. This is the center axis of the model. 
And you can rotate around this axis which is a real handy tool. 
Right click in the blue (skinned) window and a menu pops up, as shown on the right below.
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Example: Rotate around selection Center. 
Now you can left click/hold and mouse around the model with even more control. 
Remember that you have to uncheck this if you want to do the normal left click look around your model. 
Practice the techniques covered  before you move on to the next lesson. Make some boxes with different shapes and look around them. 
Get familiar with this process. It should be something you don't even have to think about. 
Some complex concepts will be introduced in the next lessons and you want to be able to use the software without thinking about how to use it. You want to be able to free yourself to actually create objects. 
Shaping our Object 
Okay, you have a pretty good understanding of how to create a simple object and how to move around and look at it from different viewpoints. 
Let's start to manipulate this object and shape it into what we want. First let's make this sword a more appropriate thickness. 
Remember, our box is pretty thick and it looks more like a door than a sword. 
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In the toolboxes on the right select the button called "Scale". It allows you to change the scale or "Size" of your selected object. 
Our newly created object is red which means it is selected. When you press the scale button everything you do will apply to this object. 
Underneath the tool box a new set of items popped up. Press the round button for Origin, then in the box above the letter "z" enter .05. Then hit the Scale button. Your sheet model is transformed into one half of a sword blade - kind of. 
About X, Y, and Z 
These are the three dimensions of any model. Looking at the front view pane X is the side to side width. Y is the height and Z is the Depth of the model. When we modified X we changed it to .05 of its original size. or 1/20th 
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Let’s take a look. Change the Z back to 1.0 and change the Y to .5 (point five) This will be half. Hit the Scale button and see how the height of your model was cut in half? You had to change the Z back to 1 because when you press the scale button you don’t want the Z to be reduced again to another .05 of what it was. 
Now change the Y height back to what it was by entering 2.0 in the Y box and hitting the scale button. Scale is a relative term and it applies to whatever the model currently is. If you put 1.0 in the Y box it would scale it to exactly the size it currently is, not the size it used to be. So because you had cut it in half now you want to double it to get it back to the original size. 
After you got it back to its original size enter 1.0 in the Y box and hit scale so everything is back to default and it doesn't cause an unwanted mistake later in the build. 
Important Note: Your Box is not a box. We talked a little bit about how making models for video games is all about triangles. Everything is based on triangles. And you probably have been visualizing your box as a red square with an X in the middle of it. Actually, it isn't. It is a series of red triangles that make up a box. And these triangles are called "Faces". Try to think in those terms. It is how real model makers think and it will make it much easier for you. 
Now we start to manipulate this object and shape it into what we want.
Ignoring the unseen surfaces 
This is only one side of our model because we want it to be perfectly symmetrical. And what this means is that one whole side will not be seen. This is the side that will be welded to the other half. Think of this as an apple cut in half. When we weld the two halves of the apple together (to create a whole apple) you won't see the insides, only the outside. 
We can tell Milkshape to ignore these inner sides and this is a great benefit because it will make the model easier to build, a smaller megabyte size, and much faster when it runs in a game. 
No sense in drawing and texturing surfaces we are not going to see. 
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  Pull down the Menu item "Window" 
(  Check the "Show Viewport Caption" item. 

More Manipulation of the Model - Ignoring Blackfaces 
Selecting the viewport caption option gives you some nice information at the top of each workspace view. Little boxes pop up at the top of each of the four workspaces as shown below. 
[image: image14.jpg]
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What we are interested in for now is the square that says "Front" (upper left). You now know this is the front view. The other three squares are also now clearly labeled.
Now let's ignore one side of this model so we don't have to worry about skinning it. It will be on the inside of the sword and welded to the other half. 
As shown on the left, In the Toolbox push the button called "Select". Then further down push the button called face. And finally, check the box called "Ignore Blackfaces".
What you have done here is brought up the selection tool. Then you said I want to select only faces (triangles) and finally you said I am going to ignore these triangles.
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Now look at your workspace. The left side is the on in the upper right square on your screen
Single Left click on one of the triangles. 
It turns Red and the rest of the model lines turn white. One triangle is now selected, as shown below (only the upper right of the workspaces – left – is shown).
Now be careful here and hold down the shift key and select the other triangle that makes up this face. 
Then Press the Delete key on your keyboard. This ignores this side of the model. You will see the following shape.
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Remember: This is not a side you are working with. It is two triangles that make up a side. 

What you see looks like a rectangle with an X in it. But it's now. The left side you are looking at it just two triangles like this. You are selecting both these triangles and ignoring them. You see an X because you are also seeing the two triangles on the far side of the rectangle.

This whole side of the model is ignored. It will make your job much easier.  Before you hit the delete key your screen should look like the following.
[image: image75.jpg]
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In the left viewport you see the side is red. And you can verify this by looking at the front and top viewports where only that side is red. 
Once this side is ignored it will be black. You can actually see into your model. If it were light in there. Or if the grid passed through it. 
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Those triangle "Faces" are kind of small. Wouldn't it be great if you could make it bigger, select and ignore the sides then make it right back to its original size? 
Next we cover selecting and sizing. 

Quickly selecting and sizing your object
 You are going to do this lots of times when making a model so you should practice it. Remember these are the basic skills you learn as second nature so you don't have to think about them. You just do them as you attempt to create what your imagination sees.
Let's select and resize our sword blade 
In the tool console panel at the right (as shown below) press the Select button, then Under the "Select Options press the face button. Finally unselect the Ignore backfaces checkbox.
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Now click and hold the left mouse button then drag it over your box. The whole box will turn red.
You have selected your box. It is the active object.
Now we are going to make it larger.
In the Control Panel, Under the Model Tab press the Scale Button. Now in the Z box at the bottom enter 10 and hit the Scale button. This makes the z dimension ten times its original size. 
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Much easier to see the triangles when the side is ten times its original size. Now you can select the two triangles easily and delete them.

 

When you are done of course you want to go back to your normal size so enter .1 in the Z box and hit enter.
This brings it back down to 1/10th which is your original size. 
Enter 1.0 in the Z box and hit enter. This doesn't do anything, it just resets everything to 1 -1 scale. You don't want to forget about having an odd number in one of those scale boxes because it will affect you the next time you hit the scale button. Always keep those numbers set at 1.
Summary: To rescale your object you:
(  Press the Select Button 

(  Press the Face button at the bottom (under Select options) 

(  Make sure the Ignore Blackfaces button is unselected 

(  Click/hold and drag over your object to select it 

(  Then select Scale button 

(  Enter your new scale 2 = double size 5 = 5 times, 10 = ten times etc. 
Do the work you want to do on the object 
And if you want to return to your original size after work is done just enter the reciprocal scale. .5=half, .01 = 1/10 etc. 
Next

 Understanding how to scale your models correctly using Reciprocal. It will make your work much easier if you understand how it works and how to quickly determine it. 
Finding the reciprocal of a number
Some elementary math for those that might need it – otherwise, this section can be skipped.
With Scaling you always have to understand that the number 1 is the universal constant. This is the number you are at. No matter what size your object face or line is at in pixels its current size is 1. 
We figure this reciprocal out by using fractions. Think of the 1 as the bottom number in the fraction and your new, larger size as the top number in the fraction.
So if we had 1/1 (The bottom number is our number here on the right) We would have a scale of exactly one which doesn’t change anything at all. 
But let’s say we put a value of 2 in one of our scale boxes x, y, or z. This will double our size. Put this 2 in the top of the fraction so we get 2/1. 
You did some work on the box and you now want to go back to your original size. Simply divide your 1 (bottom number) by 2 (top number) 1 divided by two = .5 . This .5 is the number you put in x, y, or z to get back to your original size.
Divide 1 by whatever number you put in the x, y or z box and it will give you the reciprocal you need to get back to the original size.
One more example: 
We increased the size of our left side by ten. We entered 10 in the z box. Did our work, then want to go back to the original size. Simply divide 1 by 10. That gives you .1

Enter .1 in the z box hit the scale button and you are back to your original size. 

Remember: divide 1 by your number and you get the reciprocal. 

Moving Objects 
 You are going to be moving your objects around a lot in order to work on them and in this lesson we move our object into the center line of the workspace. This will make it easier to work on and easier to understand. 
This lesson seems quite simple. All you have to do is move the model around right? Yes, but you are now going to see that you have learned a lot and you might also see that you need to brush up and reinforce the skills you have learned. 
Moving your object
[image: image79.jpg]


The image on the left shows our model exactly where we want it to be. You can see the little yellow and purple lines on the grid. These point to the exact center of your model space. You want to move your sword half so it is just like this. 
Notice how you can see the grid inside the box? This is because the dark side is the left side of the model that you defined as ignored. Now you can see inside the model.
Press the select button, then the Face button under "Select Options. Now click hold and drag over your box to select it all. 
Now press the Move button and you can left-click hold on your box and move it around. 
But it moves off the screen where you can't see the center point of the grid well. How do you fix this? This is accomplished by an adjustment of the views. 
To Move around and resize the workspace 
Press down the shift button and left click hold the mouse on one of the viewpanes and you will zoom in or out by rolling the mouse. 
Press down the ctrl button and left click hold the mouse on one of the viewpanes and you will move the workspace around. 
Move your object to the exact location that I have done. Align it right on the center point of the grid.
Okay, all of the learning about the workspace is done. Now we get into the meat of creating and manipulating the model. 
We have now covered many of the basics You can scale, size, create and do other things. You also have a basic understanding of what the workspace is all about. 
Creating and Manipulating Models
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Your Model takes shape
In the control panel, under the model tab press the Select button. 
Then in the lower section under Select Options press the vertex button. 
A vertex is a square point where two lines meet. 
Now you can click on any of the tiny vertexes in your model and it will turn red.
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The image below shows the top left vertex selected. Now you can move this vertex and the white lines will follow it. 
And voila your rectangle can be manipulated into a new shape. 
Now you can see how you can start to hammer out this sword into a real shape. 
How to move the vertex? 
Easy enough. You already know this. Just press the Move button in the control panel then click hold on the selected vertex and you can slowly mouse around moving it. 
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Now do this to the top of your sword. Select the vertex on the right and move it in so it has a sword tip look to it like this: (this is done in the front panel view) 

  

Remember that this is only half your sword so it should look only like half a sword. Picture mirroring this half over to the left and you will have a complete sword blade. And make sure you are moving the correct vertex. This is the one that is not on the side that is ignored. 

Let's make the sword get thinner too. 
In the left paneview do the same thing, Press select, then press vertex in the select options at the bottom. Select your vertex then press move and move the vertex in. 
[image: image83.jpg][ Model | Groups | Mateisls | Joirts
| Tods

| ot 4% Move ]
' =

| ]

Flediau Al Viewports
[éuto Tool

Seent)
(Gioug) o]

[lgnore Backfaces



Do the same process with the other vertex at the top left of the sword and move this vertex in so the sword comes to a nice point. 
[image: image16.jpg]



Moving a vertex only moves the line between that vertex and the next adjacent vertex. 
The whole sword length didn’t get skinnier. Just the potion between the tip and the next vertexes. 
Now you can start to see that modeling takes a bit of artistic ability and it is always a good idea to sketch out your objects on paper before you start modeling. 
They can get very complex and be difficult if you can't see how you want it to look before you actually start designing in milkshape 3d. 
Mirroring objects and models 
Now you can see why we have created only one half of a model and this is a very easy model. If we had a very complex model that took hours to create we can save a lot of time by making half then with a few button pushes we could clone that half into the other half. It's a big time saver and it insures everything looks symmetrical. 
Cloning the other half of the sword
In the tools console select the model tab, then press the Select button. In the select options box at the bottom press the Group button. Now you can click anywhere on your sword blade half and the whole thing will turn red. 
You could also use the Select/faces click drag option that you learned earlier. But use this group selection process. it is a new skill.
This is where you can see the importance of why you had to line up your half sword on the grid center. Because this is how the program calculates what to clone and where to put it. Our ignored side is right on the center line so it will become the inside of the model.
Now pull down the menu item (top of the screen) called "Edit" then select the "Duplicate Selection" item.
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This duplicates what you have selected. In this case it is this complete half a sword. But it is just saved in memory. 
Now you have to place it somewhere on the screen. To do this, pull down the vertex menu option shown on the left below and select the option called: Mirror Left <--> Right

.Your sword blade is now complete as shown on the right below.
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Grouping 
As you make models you will find the need to manipulate groups in specific ways. At this point of the tutorial we have two groups; each one is half of a sword. Now we want to manipulate them as a single group. This is done with the grouping commands. 
Now we have a new object that is composed of two halves, but the program still considers them to be two halves and we want it to be one complete entity. We are going to create a new group for the whole thing so far. 
Click the Select button in the tools console and click-drag over you whole model so it all turns red. This means that it is all selected. 
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Now press the "Groups" Tab in the console and then press the "Regroup" button.
It has formed everything together into a new group. Let’s rename this so it is easy for us to understand.
Enter a name in the input box. I put "swordblade". Then hit the Rename button. 
You now have a complete group that you can easily identify and easily manipulate as a whole. 
Grouping is very important because it allows you to very quickly manipulate portions of your model. 
 
Extrusion
Now we are faced with making the rest of the sword. And there are lots of ways we can do this. We will use two different techniques to finish off this sword model. The first technique is called extrusion. This is where we select a face on the model and we extrude it out to a new shape. 
Rotate the whole group of the sword blade so now the point is directly pointing down. 
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Remember how to do this?
(  In the Model Tab select "Rotate", 

(  In rotate options down lower select "Center of     

     Mass" 

(  Click-hold and drag in the front view window and you can 
     rotate the whole group so the point is down and the base 
     of the blade is pointing up. 
There are actually a few different ways to rotate things and if you have done it a different way that is great. This is just one way to do it. Your model should look like this:

  

Now let's just select the face we want to extrude. This is the part that we are going to create into the crosspiece. 
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Select the triangles that make up the top surface of this sword. It looks like this selected:
This face of the model is made up of four triangles. Select each triangle until the whole face is selected. If you make a mistake and select incorrect triangles just hit the CTRL-Z command to undo it. 
Move the model down in view a little bit so it is easier to work with. You do this by holding down ctrl and [image: image88.jpg]


then left mouse button hold and drag. 

 

This is so we have room to see the extrusion we are about to make. 
In the control panel, under the model tab press the extrude button. Now you can left click anywhere in the front view pane and it will drag out this surface (extrude it). Drag it out so it looks like this:
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Now repeat this extrusion process to drag out the two sides of the sword. 
You select faces, then press extrude and drag them out. Do an extrusion to the left and an extrusion to the right so it looks like  [image: image90.jpg]


the image here. 
Note: to make it easy you work in the left pane view window to select the face on that side, This drag it out in the front panel window. Then to work on the other side of the sword pull down the pane menu so it is the right side, (This is shown by the black arrow) select the triangles in the right side, then extrude it easily in the front panel. 

 

(Black arrow shows how to look at the right side or the left side) This makes it easy for you to select the triangles that make up that face)
Completing the shape of the sword. We use a couple of easy geometric additions to do this. The cylinder and the Geosphere.

Completing the shape of the sword
Now let's complete the handle of this sword. In the control panel under the Model Tab [image: image91.jpg][ Mol | Groups | Materil | Joints |
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press the button called "Cylinder". Now draw a cylinder on your sword right where you want the handle to be.
Once you got this the way you want it deselect the cylinder and then press the GeoSphere button and draw a geosphere at the end of the handle. Your model should look something like this:
Skinning the sword 
This is the process of defining which parts of the sword are grouped into which types of colors and textures.
Recall the square graphic of a dwarf.  It looked like somebody had put him in a trash compactor and squished him down. That is the skin for the dwarf model. The three dimensional model was flattened out into a two dimensional sheet
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Model created by separate program 

We are Going to do this process but not yet. There are tools within Milkshape that will allow us to color, skin, create textures and apply them to our model. 
Note that there are programs you could purchase that would make this process easier but this tutorial is all about using a little elbow grease and saving some money. So roll up your sleeves and let's dig in. 
First thing to remember is that Milkshape doesn't allow you to apply colors and textures to individual triangle it only allows you to apply to groups. Now that doesn’t mean you can't have one triangle as a group. You just have to define that one triangle (face) as a group if you need to. 
And it is this grouping that we are going to do now. We are going to break this model down into four groups then we are going to build our map out of it then apply our colors and textures.
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To do this we are going to need a paint program. I talked a bit about this in the beginning of the tutorial and almost any paint program will work but I recommend you use Paint Shop Pro. It is a cheap and very effective solution for all of your game making and web mastering needs. 
Important Note: As you are texturing your model the textures may not show up in the 3d blue view pane. This is the view pane in the lower right. This view pane has options for showing the textures. Right click on that screen and select "textured" to show textures as you work on your model. 

Mapping your Sword 
Define the model into four different groups. Of course, if you feel adventurous I recommend you actually break your model down into more groups so you can get more detail. Experiment. This tutorial is all about giving you the basic understanding. It is up to you to learn, experiment and create.
Defining your groups for mapping
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In the Control Panel, under the Groups tab you can see that I have three groups already defined. 
This was because of the process we used in building shapes. You may have more groups depending on how much experimentation you did. 
Select the Geosphere line item (it is now blue) then lower down in the control panel under "Group" press the select button. Your Geosphere turns red.
If you are doing your groups differently and want to get more [image: image94.jpg]S ke | ReEe e L
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detail by creating specific groups remember that to add faces to a group you use the Shift-left click, and to remove faces you use Shift -right click. 
Now press the CTRL+h buttons and the geosphere disappears. This is the hide command. You are hiding the selected group. It is still there. You just can't see it. 
This makes it a lot easier for you to work on the rest of the model. To make it reappear you press the CTRL+u buttons. 
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Now do the same thing with the cylinder.
(  Select the Cylinder group line item 

(  Press select so it turns red 

(  Press CTRL+h to hide it 
Now we need to break down our sword blade into two separate groups so we can assign a different texture to each part. We want the crosspiece and the blade to be different groups. 
If you remember we had made the sword blade then we extruded the crosspiece. This means that it is all one group at the moment.  In the control panel select the line item for swordblade and the whole model that you see on the screen is selected (turns red).

In the control panel press the select button then lower down select the face option. 

Now what I did was unselected from the group all the blade portions. (shift+right mouse) I did it this way because it's easier. The blade is less complex.
You could have just as easily, without the sword blade group being selected pressed [image: image95.jpg]


the Select button, face option, then Shift+left click on all the faces that make up the cross-piece. 
Either way your model should now look like this:
Let's make this a group all by itself. 
(  Press the Groups Tab 

(  Press the ReGroup Button 

(  Enter a name in the text box (I entered Crosspiece) 

(  Hit the Rename button 
You now have a new group and all we have to do is get that last group, which is the sword blade. Hit Ctrl+h to hide the crosspiece group you just made and all you are left with is the sword blade. 
Easy enough to select this, you don't even have to worry about the various faces. 
(  In control panel select the Model tab 

(  Lower down in Select options press the Group Button 

(  Left click and hold then drag over the whole blade and when you release everything 
     is selected 
Now just create this as a new group just as you did with the crosspiece
(  Press the Groups tab 

(  Press the Regroup Button 

(  Enter a Name (Blade) 

(  Hit the Rename Button 
Now when you hit Ctrl+h the blade disappears and the screen is blank. And in the control panel you have four different groups:
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Press CTRL+Shift+h to unhide everything. You can also unhide everything by pulling down the Edit Menu and selecting Unhide All. Your model is back on the screen.
Applying colors and textures to your model 
If you don't have a Paint Program of if you are not artistically inclined there are options right within Milkshape for you to get your model skinned with colors and textures. Let's take a look at this.

Milkshape has some tools right within its workspace 
You can use these texturing and coloring tools without having to work with a paint program.
The Materials Tab

This is the tool tab for working with colors and materials right within Milkshape. Press the Materials tab and take a look. 
Now press the "New" button, a material named "Material01" comes up. Check the SphereMap box then press Ambient.
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A color picker box comes up. Select a color that you want your Geosphere to be then hit ok.
You now have a new color in the program. Pick three more colors but don't check them off as SphereMap.

You now have 4 different materials that you can apply to your sword. 

 

Important Note: Don't be bashful with the colors and the Ambient, Specular, Diffuse and Emissive setting buttons. Experiment with these buttons, the colors and the color picker. You really can't make a mistake. Create lots of materials to get a feel for how everything looks.
Applying materials to the sword groups
Create four Materials for your four different groups. Mine are default labeled Materail01, Material02, etc.. You can press the Rename button and rename your materials so they match the groups of your sword - this just makes it easier to keep track of things. Or you could rename them by how they look - Gold - black, white etc. 
Apply The material
(  Press the Groups Tab 

(  Select one of your groups 

(  Press the Materials Tab 

(  Click on one of the Material line items 

(  Press "assign" 

(  The Material has been placed onto the selected group 

(  Now back in groups tab unselect the group by hitting select button 

(  Repeat this process, select another group, assign a material until all four groups have been 
     assigned a material 
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Here is the sword with some basic materials assigned to it. 
Pretty plain looking but you can get real specific with this and make it look much better by regrouping into smaller and more detailed groups. 
And by experimenting with all the functions of the materials tools. 

  

Creating and Importing our own Materials into the Sword Model we have made 
This is quite an easy process and it opens up some real fun doors for you. You can find lots of textures and colors or you can make your own and apply them to your models. 
 Get and Apply a new Material to the sword
This square of black and yellow is our practice material. We are [image: image98.jpg]


going to apply this to the Ball end of our sword. 
Right click my image here and save it as a .jpg somewhere on your computer. 

 

Now, Press the Materials Tab, Press new then press the first "None" button. A file selection box comes up. Browse to the location where you saved my black/yellow image and select it. (I called it "practice-material.jpg" If you [image: image99.jpg]


renamed it then find that named file. 
Put a checkmark in the SphereMap box. This is going to make it look pretty cool. (Remember to experiment with all these various settings and buttons. )

 

Voila, There is the new material, imported into the program and it looks pretty good.
Now you just follow the procedure you already learned. 

Go to groups and select the Geosphere (ball end of the sword) then go to materials and press the " assign" button to assign this material to the geosphere group. 
Pretty simple. I very much recommend you make more textures and experiment with this a lot. Especially the Ambient, Specular, Diffuse, and Emissive buttons - and the SphereMap button
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Here is the new texture applied to the ball end of my sword. 

Practice this: Make textures with a paint program and then import them into your model. 
Keep them organized in one folder. 
Over time you are going to have a lot of interesting textures and you will need to find them easily. 
 
Mapping Your Model (Sword)

 Now let's Map this sword the way I showed you the dwarf was mapped at the beginning of this tutorial. We are not going to do a real sophisticated mapping. I am only going to show you a simple mapping so you have the understanding of how to do it. It will be up to you to practice this and improve your skills at it. I will tell you a bit more about how to do this at the end of this section. 
To do this you are going to need a Paint Program and some skill with painting. I use Paint Shop Pro for this but you can use any paint program. To make it easy for you I have already drawn and created a simple map that you can use. So you don't really need to use a paint program. But I highly recommend you do these steps on your own. If you want to learn how to make models there is only one real way to do it and that is to do it. And do it a lot. The workspace being created is shown on the right below.
(  Pull down the edit menu option and then select "select none" This will deselect any 
     groups you have selected. 
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(  Now press, on your keyboard, the Print
     Screen button. This saves a copy of
     what you see on the screen into 
     memory. 

(  Open up your graphics painting 
     program and create a new image that 
     is 1024 pixels by 1024 pixels and with
     a background that is black. You can 
     vary the pixel size and the background
     color but stay with this so you can 
     follow along easily. 
(  Now paste the saved image onto your 
     workspace. In Paint Shop Pro you do 
     this by pulling down the edit -> Paste –

     > As New Image. 

Paint Shop Pro now has two images, the black blank one and the picture of the sword model (all four views) that you pasted.

Now using various tools like Freehand selector tool and point to point you capture the images of the sword from the picture on the right and paste them into the new image on the left. Do the top and transfer it, then do the side and transfer it twice because there are two sides to the sword. Then do the front twice. We can do the front and side twice each because the shape is identical. We can paint them different if we want to.
Note: See how in the picture we only see the top of the sword? We, of course need the whole sword so go back into Milkshape and scroll up, hit the print screen button to capture this and paste as a new image again into paint shop pro. The capture and paste the rest of the sword into the picture on the left. 
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To better understand: What we are doing here is [image: image103.jpg]


cutting out the shape of the sword so it can be painted. Here is the view of the top of the sword that I cut out of the picture on the right. I pasted this into the picture on the left
Once you have completed it you should have something that looks like this.

I have cropped the image, down to fit just the sword, there was a lot of extra black space that was not needed. Also, see that I have only 1 side image. I am just going to use this same image for both sides. 
 Now color it in.  Save the black plain one so you can open it up and try different sword looks. I quickly put this together.
And I have this file for you to use in your model. Save this picture as a .jpg with a name you will remember. 
If you don't make your own image you can use mine. Right click and save this image to your computer. Remember the name and where you put it. I call it swordcomposite3.jpg

Applying and wrapping the Image you created to your model 
We have our map now we have to import it into Milkshape and map it to our model. You already know how to do most of this (importing a picture) but now learn how to map this image to your model. 
Go Back to Milkshape 3d now
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(  In milkshape 3d pull down 
     the edit menu and choose 
     the option to select all. This 
     selects the whole sword. (Or 
     you could use the hot key 
     combination Ctrl+A) 

(  Under the Groups tab press 
      the Regroup button then 
      rename this group to 
     "complete". You now have a 
      new group that is verything. 

(  In the Materials tab press 
      new just as you did to get a 
      new color. 

(  Press the Top <none> button 
      and browse to your texture 
      (swordcomposite3.jpg) 
      and press ok. 
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(  Press the "Assign" button and the texture is applied to the whole model. But what   

  happened? 

 

You can see that it is your image and it is applied to the whole sword although the proportions and placement are all wrong. Now we fix that. This is a matter of setting the coordinates and to do that we choose the Texture Coordinate Editor.

Pull down the Window menu item at [image: image106.jpg]


the top of the workspace and select the "Texture Coordinate Editor" (Hot key is Ctrl+T) The editor pops up

(The Texture Coordinate Editor Box) 
Now Press the Region button, make sure the top menu box says "Complete" mine says blade, and ignore this. And pull down the next item and select "Front". 
Now click/hold and drag your left mouse button so it captures all of the front view of the sword (You can see this by the white lined square. You can't see all of my image just for ease of viewing. To get all of the image just maximize the Texture coordinate editor with the little tool at the very top right. 
Press the Remap button and the sword model front is superimposed right into the white square like this:

The program zipped the model right into the zone you defined. See how mine is a little bit off? You should tweak yours , Ctrl+z and undo and try again until you get it nice and lined up well. 
About the Texture Coordinate Editor - as you are working with images you are going to run into difficult with sizes and not seeing things well. Use the Scale button and the Fit Selection button to get it to a comfortable view. 
Also Important: Make sure the Redraw check box is checked. What this does is every time you hit the remap button it will redraw the model in Milkshape so you can see the 3d effect. 

 
Actually a pretty simple process. Now do the same to the other sides, (top, left, right, and back)  This is the basic process of mapping to the model. And by looking at your model you can see lots of improvements you can make. 
Our model was simply done as a whole but to get it better you would break down the model into groups so the surfaces could be finely mapped. You could also use the original four groups and map each side of each group which would give you a really good look. But you have the basics of what mapping is and now it's time for you to experiment and practice. Here's a look at my finished sword model:

 

Let's Continue, we have to now get this model over into the reality factory and that takes a bit of manipulation 

Importing the Model you made into Reality Factory (OpenGL covered later)
You made a model and now you have to get it into your game making software so you can use it in your game. Here are the steps for taking a milkshape model and getting it into Reality factory.
There are lots of different game making programs and lots of different modeling software programs. And one of the little challenges that comes along with this is the challenge of compatibility. But this is easy to overcome with Milkshape 3d and Reality Factory because they go together pretty well.
Reality Factory uses a format for its models called actor. These models are saved with the .act extension. So we have to change our model into a .act and put it and its supporting materials in the right place. 
Transforming your model into a .act file
Along with Reality factory is a tool called astudio. This manipulates model files and this is what will make your model a .act
Step 1: Pull down the File Menu, Select "Export" then select "Genesis 3D BDY..." 
Give your project a name and push the "Save" button.
Step 2: Now we need to use Astudio

Astudio is a bit tricky to find. There is no desktop icon for it and there is no menu item when you browse to Reality Factory. You have to find the start icon for Astudion in your program files.

Use Windows explorer to explore your hard drive. Astudio is in the tools folder of reality factory and the icon should look like this: [image: image22.jpg]32 AStudio




If you used the default installation for Reality Factory the browse path should be: 
C:\RealityFactory\tools
Double click that astudio icon and the astudio program comes up.

a. Pull down File and select New 
b. type the name you want to give your model into the project name box and click ok
c. click on the body tab and select genesis3d body(.bdy). 
d. click the Browse tab and goto THE TOOLS folder where you exported your genesis .bdy file and select it. 
e. you should now see your .bdy file come up in the file name window of astudio 
f. Click on the paths tab and where it says materials directory type in c:\Reality Factory\tools and press the build button. 
g.The model has been imported into Reality Factory 

Getting the Model into your level
There are a couple of ways To get a .act file into your level. 

1. copy the .act file from the tools folder and paste it into to the actors folder in r.f 
place a staticentityproxy into your level and where is says szActorFile type in the name of the .act file from the tools folder 
compile your level and your model should be there.
To see the entity attributes click on brush select then click on the staticentityproxy you created. The Attributes box comes up on the right of the workspace. 
This szActor file type is a property in the Entity Attributes box. You select the entity you created and inspect the attributes. The szActorFile line item is down low so you may have to use the scroll bar to find it. This line is where you enter the name of your model. 
2.You can also copy the .act file from the tools folder and paste it into to the actors folder in r.f and 
place a pawn into your level. 
Next: Animation

The Process of animating a model is not hard to understand and you will grasp the concepts quickly. 
You already have most of the skills needed to do it as far as selecting and moving parts of your model. 
Now you just need a few more bits of information to put it all together. That's what we are going to cover now. 
Animation
The model we are going to animate is shown below. The basic framework for the animation comes with Milkshape so that is easy. We will focus on getting it to move. 
Making 3d Animations in Milkshape 
3D animations used to be a very time consuming thing. An artist would have to draw every individual frame of an animation. If it was needed for a model to walk a lot of work went into drawing many different pictures that had to be assembled together. With animation programs you just have to define the beginning and ending point of the animation and the program figures out all the middle steps. 
About Animation
Milkshape does most of the work for you when it comes to your animation. But you are going to see, as you make models that there is a bit of distortion that occurs. 
Milkshape will move your animation in specific ways and as your models get more complex you will see that the move distorted things in ways that you don't want. This means that you would go back into the model and adjust the screen mesh and the faces. Something like this comes with experience and with a little bit of practice you will be able to see and do this well. 
For now we are just going to learn the basics of animating a model. From there you will have the skills to improve yourself.
Frames and Keyframes 
We talked a bit about how you will define the beginning and ending points of an animation. These points are called "keyframes" and milkshape will figure out all the points in between these two points. It does this by building its own frames. These are just normal frames. 
You define the keyframes and milkshape puts the frames in between. 

If your model were to move its arm up into the air you would define the hand in the down position and then in the total up position. These are the two keyframes. Milkshape would figure out all the frames in between. 
Each frame in an animation from beginning keyframe to ending keyframe is a position, and a time interval. You will define how long it takes to move from frame to frame. 
Joints Bones and Skin 
We are finally getting to the joints and bones of the skeleton. We discussed these in the beginning of this tutorial but until now we have never used them. We just focused on the look of your model which is the skin. 
When animating a model you have to work with the joints and bones. These are what move and the skin will move with them. And this is where you can see that experience and practice will come in. As your joints and bones move the skin will distort in way that you don't like. You would have to go back and tweak the look of your skins to get it more appealing.
The Hierarchy of Joints and Bones
There is a distinct thing about bones and joint that you should know. A skeleton is built step by step and each step is the child of the step before it. Take a look at this:
Open Up a model 
Pull down the file menu and open up the model called: valve_skeleton. It is in the root Milkshape folder and you may have to browse up one level to find it. It looks like this:
Now let's select a joint. 
In the Control Panel select the "Models" tab Now press the "Select" button Then down below under select options press the "joint" button. 
Now left click on the joint at the wrist of the model. After selection it looks like this:
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Notice how the hand turned green but the forearm didn't. This is because selecting a joint only activates the children of that joint. 
Now select the joint at the elbow and see what happens.
Now the forearm, wrist and hand are all green and all selected. These are the children of this joint. 
This is important because these are all the parts that will move. If you tell the elbow joint to move all its children joints will move too. Seems straight forward but if you select a joint in the torso of the model you can see lots of children will move. 
Experiment with this and try clicking on different joints to see what happens. With a humanoid model you can pretty much guess what will happen but when you are creating things and creatures this is something you have to pay close attention to. Just remember that there are children and parents of joints. 
The Animation slider toolbar
The Animation slider tools
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Press the "Anim" button in the lower right of the workspace and the animation toolbar comes alive. 
Look to the far left of the animation tool bar. You see a little slider tool and along the length of the bar you see little hash marks. 
[image: image25.jpg]



This image shows 4 hash marks. These hash marks are frames in your animation. If you move the slider it will move through the frames of your animation. Right now you have no animation so nothing happens. 
The slider is currently on the first hash mark, or frame. You will define this first frame making it a keyframe. Then you would define a new position of the model and define this new position as a keyframe further down, say at hash mark 10. Then you would tell milkshape to fill in all the steps in between. 
There is an easy reference for these frames. On the right of the animation tool bar the two little boxes tell you what frame you are looking at and how many frames there are in the animation. This image shows I am looking at frame 1 and there are 30 frames in this animation. Move the slider and see how it changes. You can also input numbers into these boxes to change them. 
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The buttons here are pretty easy to understand they allow you to move forward and backward easily. As you create animations you can experiment with these buttons. It will make animating a bit easier and faster. 

A Simple Animation
It is good practice to start out your animation with the model being in the relaxed position. This is with the model just as it is with no joints selected. It is your starting point and your first keyframe. 
So if you have been tinkering with joint selection you can left click anywhere on the screen to deselect joints. Or you can pull down the Animate menu item and uncheck the "Operate on Selected Joints Only" This will deselect all joints. Now select everything as your first keyframe. Do this by pulling down the Animate menu item and selecting "Set Keyframe".
Your whole model changes colors. All the bones turn yellow.

 

This means that all of these bones have been assigned to a keyframe. In position 1.This is the beginning position of your animation. Now let's finally make it move. 

 

 
Making Things Move
We are finally going to actually make something move. You have been waiting a long time for this. But there has been a lot to learn and this is what you got to do if you want to make models and animations for computer games. You have to learn the stuff it takes. 
We are going to move both the arms of this model as if he were flapping wings. And we are going to do this by setting the up position of the arms at frame 10. This frame 10 will be our keyframe. All the other steps in between will be defined by milkshape. 
(  Move the Animation slider over to the tenth hash mark or input 10 into the box. 

(  Pull down the Animate menu item and check the "Operate on Selected Joints Only" 
(  Now select a shoulder joint (You do this in the control panel under the models tab, 
     then press the select button then down below press the joint button) 

(  Now press the rotate button and left click/hold and drag the arm into the up position. 
Now do the same thing with the other arm.
(  Select button 

(  Joint Button 

(  Click on the other shoulder 

(  Rotate button 

(  Move the arm to the new position 
Now make sure both joints are selected and both arms are green. Do this by pressing select then shifting and selecting the other shoulder joint. It should look like this.

Now let's define this new position in frame 10 as a keyframe.

Pull down the animate menu item and check the "Operate on Selected Joints Only" item. This tells the program only to do the operation on the two selected joints - and their children. 

Pull down animate again and select "Set Keyframe". You have just assigned the new position of the model into frame 10 and as a keyframe. Now Milkshape will figure out all the middle steps. 
In the Animation tool bar press the "Anim" button then the little play button (It looks like this: > )and your model takes off. It flaps its wings. Voila. Your first animation. 
Make this a bit more complex. 
Go to frame 20 and move the arms to a new position. I moved them forward. Set this as a new keyframe and watch your animation. Now let's complete the waving of the arms by bringing them back to the original position. To do this we can copy our first keyframe, which is the original position into the frame at 30 and set it. 
This will cause the animation to completely rotate his arms right around and back to the starting position.
All you have to do is copy and paste the keyframe. 
(  Move the keyframe slider to frame 1. 

(  Pull down the Animate menu item and uncheck the Operate on selected joints only. 

(  Pull down the animate menu item again and select "copy Keyframe" 

(  Now slide over to frame 30 and pull down animate and select "paste Keyframe" 

(  Pull down animate menu item and select "Set Keyframe" 
This sets everything and you can press "Anim" then play your animation. Watch your model do the whole motion.
Example 2: Creating an Airplane
Introduction
This is intended as a streamline guide to get you started in MilkShape 3D. It should hopefully help you understand some of the concepts that are used when modelling.

For this tutorial we will build a simple model of a plane using various techniques. When modelling, it is common to stick to one feature such as extrude and shape the faces using scale and move as the model progresses. We are going to tackle the task by using a combination of face creation using placed vertices and extruding faces.

This tutorial is very much 'on rails' but if you feel that at any point you are getting bored or just don't like the way I'm doing things feel free to break off and try it you own way. After all, self-tought skills are often the hardest to forget, just reading instructions doesn't give the same learning. Trial and error is how I learned to model.
Mid-Section
To start off with we will create one half of the model, this is becuase the model will be symetrical. The only way to guarantee symetry is to work with one half, duplicate it then mirror it. When working in this way you also have to remember to weld the vertices in the middle of the model to the adjoining vertices of the other half so that the completed model is shaded properly throughout its vertical equator. For the sake of perfection we wouldn't like to leave it in two halfs anyway.
1. To start off with, create a box. Do this by clicking box on the Model tab of the Toolbox on the right. 
2. Create the box in the Front perspective in the top left viewport, this is really just a matter of preference. 
3. Drag the box from the top left grid line...
4. to the bottom right grid line to create a box whos extremes lie on a grid line, this again is another preference rather than a must but it ensures the steps mentioned later will give the desired effect.
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5. The box will turn red to indicate that it is selected. Select the scale tool from the Model tab, the same panel you selected the Box tool from. In the Scale Options panel that appears below the main part of the Model panel enter 0.2 in the box above the Y axis button. This panel is explained more in the Toolbox: Model section. Then press the Scale button.
[image: image28.png]I~ Auo Tool

Scale Options

@ Cerier D Mase

 oign

 UserBaig

5 o [5ek]
=





This box will form the main part of the fuselage of the plane we are creating.
6. I usually prefer working with the left hand side (viewed from behind) of the model when creating symetrical models so we will delete the faces that are facing to the right (when viewing the model from the back). Click the Select button in the model panel then click the Face button in the panel that pops up below this. Make sure the 'Ignore Backfaces' checkbox is checked.
7. Goto the viewport that has Left side view in the Viewport Caption. If none do then just click the drop down perspective list and select the Left view. If the viewport caption is not visible then click the menu item Window->Show Viewport Caption.

8. Select the two faces (triangles) that make up the side of the box. Do this by holding in shift and clicking approximetely in the centre of both faces, their wireframe outline will appear red to indicate they are selected. Press delete, this will remove the faces.
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One side of the model should now have no faces. The inside of the model is usually black as this is where no light reaches.
9. Now we are going to scale the box and move it so it is on the line of symetry (in this case the YZ plane). Use the select tool with the Face button pressed in, except this time uncheck the 'Ignore Backfaces' checkbox. Drag a selection box over the box in any view to select the whole model.
10. Click the Move button in the Model panel. In the panel that pops up below, enter 10 in the box above the X button then press move. This moves the box over 10 units. You will notice that it does not sit on the line yet, but the next step will make this so. You will come to realise that at this zoom level (in the 2D orthographic viewports) that each grid unit equals a 20 by 20 unit area. Therefore moving the box by 10 units moves it halfway through the grid boxes.
11. Click the Scale button. The Scale panel will pop up below the main Model panel. The last operation left the value in the Y box at 0.2 so to avaid changing the Y axis again enter 1.0. Enter 0.5 into the X box then press 'Scale'.
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12. This block represents the mid-section of the plane's fuselage so we will shape it a bit better, after all a blocky mid-section would look kind of boring. So Use the select tool but instead of pressing the Face button in the Select Options panel, press the Vertex button instead, make sure 'Ignore Backfaces' is un-checked.
13. Use the Front viewport perspective and select the top left vertex of the box (a vertex is a dot in the viewport it appears bigger than the lines that construct the model wireframe). Because 'Ignore Backfaces' is turned off the vertex toward the front and the vertex towards the back in the region you selected are both selected. This is what we want.
14. Use the Move tool again and click and hold in the viewport in which the vertices were selected and drag the vertices up a bit.

15. Do the same again with the vertices on the bottom left of the box. 
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16. The next step is to bring in the vertices to the back right of the shape. In the top view select the vertices at the top right hand corner of the shape. Move these vertices to the left a bit, bringing them closer to the center of the x axis. Here is the result.
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Front of Airplane
17. Now we can start forming the front of the aircraft. Choose the Select Tool and in the Select Otions panel choose Face and make sure 'Ignore Backfaces' if checked. In the Front viewport (remember that if there is no front viewport, use the viewport caption to change one of the others to a front viewport) select the two prodominant faces (the ones facing you). Remember to select these faces hold shift and click approximately in the centre of each face.
18. Now go into the Top perspective. From the Model panel on the Toolbox, choose the Extrude tool.
19. In the Top viewport click and hold in an area just off to the side of the model, drag the cursor down. The faces that you selected will start to move down as you move the cursor down. This is called an extrude operation, new faces are created in the gaps between the selected faces and the faces that they were attatched to. Keep extruding until the faces reach about halfway through another grid square, to stop extruding just let off the mouse button. If you cannot get a good view of the extrude operation as you perform it, Undo (Ctrl+Z) the extrude operation and press Control on the keyboard and Left Click and drag in the viewport. This pans the camera around. Notice, in the following image, the extrusion to the front of the shape we had before.
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	Note: At this Point you may want to take into consideration the different types of shading available in the 3D viewport. Throughout this tutorial I have been using Flat Shaded. This is becuase polygons are more defined in this view than in Smooth Shaded; the default. Flat Shading is useful in model creation whereas smooth shaded is good to see the final result. To change the shading type right click in the 3D viewport and from the popup menu choose Flat Shaded.


20. This new extrusion is the first part of the front of the plane. We will shape it a bit now. In the Top viewport, select (with Vertix and 'Ignore Backfaces' unchecked) the vertices to the bottom right of the model (the ones on the extrusion that we just made). Use the move tool to shift these a bit to the right to create a shallower gradient than that of the line above it, i.e. creating an acute angle instead of the obtuse angle it was after extrusion.
[image: image34.png]Acute angle

Moved Vertices




21. Now deselect the moved vertices (just click in the viewport with the select tool). Go into the Left viewport. The extrusion should be to the right of the viewport now. Use the select tool again (with Vertex and 'Ignore Backfaces' unchecked) and select the two vertices to the top right of the extrusion. Move these up a bit.
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22. Deselect the vertices. Go back to the Front view and again select (Faces with 'Ignore Backfaces' checked) the front two most prodiminant faces (the two facing you in the front view). Remember to select these faces hold shift and click approximately in the centre of each face.
23. Go to the Top view. Extrude the faces as we did in the last extrude operation; downwards, about one and a half grid squares in distance this time.
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24. Use the select tool (Vertex and 'Ignore Backfaces' unchecked) to select the vertices in the bottom right corner of the extrusion that was just created, this will select both the vertex you can see and the one underneath it.
25. Use the Move tool to shift the selected vertice to the left, bringing them closer to the centre point on the x axis.
26. To add a bit more shape, I used the front view to select the top left vertex on the extrusion that was just created, I moved this down a bit because this is very near the tip and will give it an aerodynamic look. I also moved the vertex to the top right of the new extrusion down a bit in the front view. I used the Select tool with Vertex and 'Ignore Backfaces' checked. In the top view I also selected the bottom left vertex of the previous extrusion, then used the left view to drag it up a bit. Finally I selected the two top vertices at the opposite end of the model (in the top view using 'Ignore Backfaces' with the select tool) and moved them down a bit using the left view.
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	Note: If you have been using the Toolbox to select a tool each time, let me introduce you to shortcuts. MilkShape 3D is designed so you can have one hand on the keyboard and one on the mouse, using the keyboard hand to select shortcuts and the mouse for the actual modelling. The shortcut for Select is F1 and Move is F2, these are the ones you will probably use the most, but of course that depends on your work methods. See the section on Shortcuts for a full run down.


26. For the tip of the plane, select the front two faces of the model in the front view with the select tool (Face, 'Ignore Backfaces' checked), then once again extrude them. Extrude them about half a grid box in distance.
27. To create the tip is easy, if you have not done so already deselect the faces. Now use the select tool (Vertex, 'Ignore Backfaces' unchecked) and select in the top view (or appropriate) the vertices of the new extrusion. Now goto the menu and click Vertex->Snap Together (or Ctrl+N) don't deselect the vertices just yet... After snapping you must remember to weld (it may not always be neccessary to weld but this depends on your needs), so goto the menu and click Vertex->Weld Together or (Ctrl+W). You now have one vertex where four previously existed.
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28. Don't deselect the vertex just yet, Move it to the x axis centre line to the left. To keep with the laws of airodynamics (roughly) I have also moved the bottom right vertex of the previous extrusion a bit more to the left, towards the centre of the x axis.
[image: image39.png]Result
Top





Tail of Airplane
29. Now we will start to work on the tail of the airplane. Change your front view to a back view if a back view is not already available, if you do not know how to do this see the Viewport Caption section or right click in the viewport and from the popup menu choose Projection->Back.
30. Now for the aid of making future modelling easier, to temporarily hide sections that we are not working on we will create a new group and hide it. Click on your Groups tab on the Toolbox. In the list box immediately below the Group name on the tab you should see one group called 'Box01' by default. This is because the first thing we created was a box.
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31. In the box to the right of the Rename button enter 'MidSection' then press the Rename button.
32. Next, in the top view use the select tool (Face, 'Ignore Backfaces' unchecked) to select the faces shown in the next image.
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33. Now, with these faces selected, goto the Groups panel again and click the Regroup button. A new group will be created called Regroup01. This group contains the faces that were selected. Enter the name 'Front' in the box next to the Rename box then press the Rename button. Two groups are now shown in the Groups list box, MidSection and Front. Click on the Front group in the list box and click the Hide button. This removes the group from the display so that it is easier for use to model the back of the aircraft.
34. We can now model the back of the aircraft. In the back view that you created in a viewport (step 29) select the two faces facing you (with select tool, Face and 'Ignore Backfaces' checked).
35. In the top view (or the left view whichever you prefer) extrude these faces about three quarters of a grid box distance. Don't deselect yet... create another extrusion in the same manner about the same distance. These extrusion will form the basis of the tail. Now deselect the faces.
36. Now using the select tool (Vertex, 'Ignore Backfaces' unchecked) in the top view select the top three vertices down the right hand side of the model and the Move them to the left a bit.
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37. If you have not got a Right side view visible change your Left view to a Right view. Choose the select tool again (Face, 'Ignore Backfaces' checked). Now select the two faces on the side of the last extrusion, these are facing directly toward you in the right side view. Remember to use the shifl key when selecting multiple faces, and to click approximately in the middle of each face you mean to select.
38. In the Top viewport, use the extrude tool on the Model tab of the Toolbox to extrude these faces about three quarters of a grid box in distance to the right.
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39. Deselect the faces. This will form the back wing of the plane. Still in the top view use the select tool (Vertex, 'Ignore Backfaces' unchecked) to select the top right vertex of the new extrusion. Move them back a touch to create an airodynamic look, much as they would look like on a commercial airliner. Do the same with the lower right vertex of the same extrusion. Move it back a bit and in to the left a bit.
40. In the Right viewport, use the select tool (Vertex, 'Ignore Backfaces checked) to select the four vertices of the new extrusion, the ones that you just moved in the previous step. Don't drag a region over them because you will end up selecting other vertices as well. Instead drag a box around the first two, to the front then hold shift and drag a box over the next two, to the back. 
41. Use the scale tool on the Model tab of the Toolbox, then click in the Right viewport and hold, drag the mouse down to make the top and bottom vertices come closer together. When you are satisfied with the height between the vertices. This is called an arbitary scale operation. If you wish you can move the vertices up a bit before deselecting them.
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42. Now we will create the back fin of the aircraft. In the top view select (I'll leave you to figure out the select configuration combination for this one) the two faces at the top of the model on the new extrusion that was created, these are the two faces to the left of the tail wing we just created.
43. Use the extrude tool in the back or right viewport to extrude the faces up a bit.
44. Using the scale tool, perform an arbitary scale operation (mouse click-hold and drag), in the top view port to decrease the width of the extruded faces (they should be the selected ones). Decrease the height of the section a bit as well. 
45. Next, move the two selected, extruded faces to line up with the back of the model. Then move them to the right a bit to be closer to the back fin.
46. From the back view, with the same faces still selected, use the Rotate tool in the Model tab of the Toolbox to rotate the faces. Do this by clicking and hold in the back viewport to the right of the faces then drag the mouse cursor down. The way the faces rotate in reaction to the direction you drag in depends on where you originally clicked to begin the operation. The markings shown in the image are just a guide. This operation is called an arbitary rotate operation, that is controlled by the mouse and not actual values (as would be entered in the Rotate Options panel that appears upon selection of the tool see the Toolbox: Model section for more details).
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47. From the back view Move the faces down and to the left a bit. Then extrude them upwards, creating the back fin. Feel free to shape this as you desire, using any tools you deem neccessary.
48. We are now getting close to something resembling an airplane. We will create another group of the back section so that if we require it, we can hide it. Select the faces shown in the image below, using the select tool. Goto the Groups tab and click Regroup, rename the group 'Tail' (do this by entering the name in the box first then clicking the Rename button). 
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The Wing
49. The wing will be realtively simple, or at least, it should be by now. Unhide the Front group in the Group panel of the Toolbox, do this by clicking on the name of the group in the list box then click the Hide button. The Hide button acts like a toggle, turning the display of the group on and off depending on its current display setting (visible/not visible).
50. Goto the Right side view of the craft. Select the vertex indicated in the image below and move it to be in a straight line with the remainder of that section.
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51. Now, still in the right view, select the four faces that are immediately to the right of this vertex that you just moved. (I'm assuming now that you know what Select Options to choose).
52. In the top view Extrude these faces to the right, about one and a half grid boxes distance.
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53. Still in the top view use the select tool to select the vertices at the back of the wing (to the top in the image above). Move these vertices back a bit more to create a streamlined effect, move them to the right a bit more as well as this will be the part of the wing that protrudes the furthest from the fuselage.
54. I finished up the wing by moving the other two sets of vertices to the front of the wing (the vertices to the bottom of the wing in the image above) into a position that would give a better look of aerodynamics. I also selected all of the wing vertices (six in total) and scaled them in the right view in height for a structure that would cut the air better (if it were a real plane). Here is the final top and right views of the wing.
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Tidying Up & Finishing Off
55. If you were paying particularly close attention during the modelling process you would have realised that there were new faces created as we went along on the side visible from the Left side viewport. Change your right viewport back to a Left viewport, there are nine faces in total to be deleted, so use the select tool and select the faces shown in the image below.
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56. Just press delete to be rid of these unwanted faces. Keeping them won't make any physical difference to the overall structure of the plane but they add to the poly count and aren't seen so we should remove them.
57. When we extruded the wings we selected four faces in total. When we did the extrude operation an extra four faces were created in the wing shown in the image immediately below. To get rid of these faces is quite a complex operation so I will elaborate.
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57.1. Goto the front view.

57.2. Hide the Front group (in the Groups tab of the model panel). Hide the tail group as well if you are having difficulty seing the faces properly.

57.3. Using the select tool, select the two faces on the front of the wing section still shown, these are shown in the image below.
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57.4. Press delete to remove them.

57.5. Now change to the back view and hide the MidSection group, unhide the Front group.

57.6. Use the select tool again to select the two offending faces which face backwards, shown in the image below.
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57.7. Press delete to remove those 'waskawy fwaces' - Elmer Fudd joke.
58. Because of the extrusion of the wing and the faces we deleted the shading of the model will now be wrong (look strange) when we come to finally give it a shading group (more about this later). So we have to weld the vertices that were left behind. For every vertex between groups and on the wing, select it then press Ctrl+W to weld the vertices. Why is this you ask? Because in certain places in the model two vertices exist where it might seem like there is only one, don't get paranoid, this happens as a result of the modelling process we used in this tutorial. To sort it, for every vertex selected in the image below, select them individually (one at a time - I have only selected all the vertices in this image to show you which ones need welded) and press Ctrl+W or click menu command Vertex->Weld Together. As you do this and before you start, goto Tools->Show Model Statistics and check the number beside the vertices entry (at the top). You should see the number decrease as you progress. I managed to get the number from 53 to 43.
[image: image54.png]



59. Now that the model is clean, here comes the last bit. Use the select tool to select all of the faces in the model, this is done to select the whole model (all groups), you could also use the groups panel to individually select each group or use the select tool with the 'Groups' option.
60. With the model selected goto Edit->Duplicate Selection (Ctrl+D). Then goto Vertex->Mirror Left <--> Right. You will now see in the 3D view a complete aeroplane, but we are not finished yet. Deselect the duplicate.
61. The vertices down the middle of the model are not welded together, becuase it's a duplicate of the original. The effect this would have in the final shading is that a split would be obvious down the centre of the model. This split cannot be seen in Flat Shaded so switch to Smooth Shaded briefly to see the effect (right click in the 3D viewport and select Smooth Shaded from the popup menu).
62. We must therefore weld all the vertices down the centre of the model. The image below shown all the vertices that must be individually welded. As said before the image only shows all the vertices that must be welded... individually. So start at the front of the model in the top view with 'Ignore Backfaces' checked when using the select tool so that you don't select any of the underlying vertices (remember that there are vertices on the underside as well), then weld them as before. Then switch to the bottom view and do the same again. The vertex at the front of the plane only has to be done once as it is a point. Use the back or front view to make sure you are selecting only a vertex from the top OR the bottom side, NOT both. Switch to Smooth Shaded while you are doing this to see the effect it is having on the shading of the centre part of the plane.
63. Lastly, we will assign a smoothing group to the model. So use the select tool to select all of the model. Goto the groups tab of the Toolbox and in the Smoothing Groups panel to the bottom of the Groups tab click assign if it's not already pressed down (if should be paler if pressed down) then press 1. This should clean up the last bits of shading on the model. As you assign Smoothing Groups you may want to assign different groups or faces to different Smoothing Group numbers. Think of the 32 numbers there as 'slots' for you to store your Smoothing Groups in. To read more on Smoothing Groups goto the Toolbox: Group section.
Final Product
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Note: the left 2 panes have been cropped for the picture on the left.





The Scale button allows you to chane the scale or size of the selected object.





Note the X, Y, Z coordinates at the bottom.
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